Praktikum 8

Dasar Pemprograman Android
(Instalasi Java JDK, Eclipse IDE & Android SDK)

Pokok Bahasan

e Konsep Pemprograman Bahasa Java pada Android

o Deklarasi Pemprograman Java pada Android

e Penggunaan import dan resource

Tujuan Belajar
e Mengetahui cara instalasi Java JDK, Eclipse IDE, dan Android SDK.

e Mengenal tentang konsep pemrograman java untuk Android

e Mengenal pemprograman berorientasi obyek untuk Android

Pendahuluan

Android merupakan adalah perangkat lunak terdiri dari OS beserta tool dan library
lainnhya yang dikembangankan oleh perusahaan Google, dan bersifat Open Source.
Saat ini disediakan Android Software Development Kit (SDK) sebagai alat bantu dan
APl diperlukan untuk mulai mengembangkan aplikasi pada platform Android
menggunakan bahasa pemrograman Java, sehingga mudah digunakan untuk belajar
membuat aplikasi. Fitur-fitur Android antara lain:

e Mesin virtual Dalvik dioptimalkan untuk perangkat mobile

e Integrated browser berdasarkan engine open source WebKit

e Grafis yang dioptimalkan dan didukung oleh perpustakaan grafis 2D, grafis
3D berdasarkan spesifikasi opengl ES 1,0 (Opsional akselerasi hardware)

e SQLite untuk penyimpanan data

e Media Support yang mendukung audio, video, dan gambar (MPEG4, H.264,
MP3, AAC, AMR, JPG, PNG, GIF)

e Bluetooth, EDGE, 3G, dan WiFi (tergantung hardware)

e Kamera, GPS, kompas, dan accelerometer (hardware tergantung)

e Lingkungan Development yang lengkap dan kaya termasuk perangkat
emulator, tools untuk debugging, profil dan kinerja memori, dan plugin.

Framework Aplikasi
e Pengembang memiliki akses penuh framwork APl yang sama yang digunakan

oleh aplikasi inti. Arsitektur aplikasi dirancang agar komponen dapat digunakan
kembali (reuse) dengan mudah.
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e Setiap aplikasi dapat memanfaatkan kemampuan ini dan aplikasi yang lain
mungkin akan memanfaatkan kemampuan ini (sesuai dengan batasan keamanan
yang didefinisikan oleh framework). Mekanisme yang sama memungkinkan
komponen untuk diganti oleh pengguna.

e Semua aplikasi yang merupakan rangkaian layanan dan sistem, termasuk:

(o]

View Set kaya dan extensible yang dapat digunakan untuk membangun
aplikasi, termasuk daftar, grids, kotak teks, tombol, dan bahkan sebuah
embeddable web.

Content Provider yang memungkinkan aplikasi untuk mengakses data (seperti
dari daftar kontak telp) atau dari data mereka sendiri.

Resource Manager, yang menyediakan akses ke kode sumber non-lokal seperti
string, gambar, dan tata letak file

Notifikasi Manager yang memungkinkan semua kustom aplikasi untuk
ditampilkan dalam alert status bar

Activity Manager yang mengelola siklus hidup aplikasi dan menyediakan
navigasi umum backstack

Android Runtime

Android terdiri dari satu set core libraries yang menyediakan sebagian besar
fungsi yang tersedia dalam core libraries dari bahasa pemrograman Java.
Setiap menjalankan aplikasi Android sendiri dalam proses, dengan masing-
masing instance dari mesin virtual Dalvik (Dalvik VM).

Dalvik dirancang agar perangkat dapat menjalankan multiple VMs secara
efisien. Mesin

Virtual Dalvik dieksekusi dalam Dalvik executable (.dex), sebuah format yang
dioptimalkan untuk memori yang kecil. Dalvik VM berbasis, berjalan dan
dikompilasi olen compiler bahasa Java yang telah ditransformasikan ke
dalam .dex format yang disertakan oleh tool "dx".

Dalvik VM bergantung pada kernel Linux untuk berfungsi , seperti threading
dan manajemen memori tingkat rendahnya .

Linux Kernel

Android bergantung pada Linux Versi 2.6 untuk inti sistem pelayanan seperti
keamanan, manajemen memori, proses manajemen, susunan jaringan, dan
driver model.

Kernel juga bertindak sebagai lapisan yang abstak antara hardware dan
software stacknya.

Android ADT

Android Development Tools (ADT) merupakan plugin untuk Eclipse IDE
yang didesain dengan kemampuan yang lengkap dan terintegrasi untuk
membangun aplikasi Android.

ADT dapat meningkatkan kemampuan yang dimiliki Eclipse to agar dapat
digunakan untuk membuat project aplikasi, membuat uer interface,
menambahkan beberapa package yang berkaitan untuk membangun aplikasi
dengan framework application user interface (API) pada Android.
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e Disamping itu kita bias melakuka debug menggunakan Android SDK tools,
meskipun sudah dalam bentuk file aplikasi yang telah jadi .apk dalam rangka
menggunakan aplikasi Android yang telah dibuat.

Praktek 1: Instalasi Java JDK, Eclipse IDE, dan Android SDK

1. Periksa PC masing-masing, dan pastikan telah bekerja dengan baik.

2. Periksa apakah beberapa perangkat lunak yang diperlukansudah tersedia
antara lain:
o OS Windows XP/7

Eclipse IDE for Java (122 MB)

JDK 6 atau 7 ( kalau sudah ada gak perlu install 1g) 70 MB

Android Development Tool Plugin (4,8 MB)

Android SDK (34 MB)

o O O O

Berikut adalah cara instalasi Android:

1. Instal JDK, apabila sudah pernah menginstall maka tidak perlu menginstall lagi.

2. Extrak Eclipse IDE yang sudah di download. Kemudian ekstract pada directory
yang mudah diakses. Jika telah siap maka jalankan Eclipse, dan akan ditampilkan
logo seperti berikut:

INDIGO

-
—eclipse

3. Kemudian pilih menu Help > Install New Software...

@ Welcome
(# Help Contents

{37 Search
Dynamic Help

Key Assist... Ctrl+Shift+L
Tips and Tricks...
Cheat Sheets...

Check for Updates
Install New Software...

About Eclipse SDK
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4. Klik tombol Add... di kiri atas, lalu muncul Add Repository, disini kita bisa
masukkan ADTnya secara online dengan memasukan alamat repository Android
(https://dl-ssl.google.com/android/eclipse/).

= Add Repository @
Mame: ADT Plugin Local...
Location:  https://dl-ssl.google.com/android/eclipse/ Archive...
3 —————————
'\?) 0K Cancel

5. Jika secara offline dengan menekan tombol Archive dan arahkan ke file yang
telah kita download sebelumnya, seperti betikut:

= Add Repository @
Mame: ADT Plugin Local...
Location:  jarfile:/D:/INSTALLER/Android SDK/ADT-18.0.0.zip!/ Archive...
A
'\\?,' [ 0K ] | Cancel |

Jika terdapat Warning seperti gambar dibawah maka tekan OK.

= Security Warning =3 @

‘Warning: You are installing software that contains unsigned content. The authenticity
! % orvalidity of this software cannot be established. Do you want to continue with the
installation?

[ ok [ cancd || Details>> |

6. Setelah proses diatas selesai dilakukan, maka selanjutnya jalankan eclipse dan
tentukan directori Workspace, seperti contoh dibawah.

= Workspace Launcher ==
Select a workspace

Eclipse stores your projects in 3 folder called s workspace.
Chaose a warkspace folder to use for this session.

Workspace:  D:\CobaAndraid -~ | Browse.

| Use this as the default and do not ask again

7. Setelah proses diatas selesai dilakukan, maka selanjutnya pilih Window >
Preferences > Android, lalu browse ke folder SDK Android lalu tekan Apply,
tunggu beberapa saat, lalu tekan OK.

8. Pilih lagi Window > Android SDK and AVD Manager, nah disini Kita harus
mendownload lagi file yang kita butuhkan, misalnya ingin buat aplikasi yang
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berjalan di Android 2.1, maka download lah SDK Platform Android 2.1, lebih
baik kita download sama Sample dan Documentation agar memudahkan kita
untuk mencari dokumentasi dan belajar dari source code yang sudah ada.

Android SDK Manager E@
Packages Tools
SDK Path: C:\Program Files\Android\android-sdk\
Packages
Name API Rev.  Status
> [ Tools
> [[] 1) Android 4.0.3 (4P115)
. [ 1] Android 2.2 (APIS)
4 [[]1Z] Android 2.1 (APIT)
] SDK Platform 7 3 ¢ Installed
D& Samples for SDK 7 1 Pinstalled
[7] & Google APIs 7 1 Spinstalled
> [ Extras
Show: Updates/New [¥]Installed  [7] Obsolete Select Mew or Updates Install pac
Sort by: @ APl level _ Repository Deselect All Delete packages...
13 - u
Fetching URL: https://dl-ssl.geogle.com/android/repository/repository-6.xml

9. Bila langkah-langkah diatas telah dilakukan dengan benar maka dapat dikatakan
selesai instalasinya, Selanjutnya langsung bisa memulai membuat aplikasi dengan

memilih File > New >Android Project.

= Java - Eclipse SDK

Edit Run Source Refactor Mavigate Search Project Window Help

Mew Alt+Shift+M » | (24 Java Project
Open File... |22 Android Project
Close crew | L2 Froject=
Close All Ctrl+Shift+W | ¥ Package
Save Ctrl+5 Gl o=
A & Interface

£ Fron

10. Pada contoh ini akan membuat Android Project dengan nama CobaHellol.

= New Android Project

Create Android Project
Select project name and type of project

= [ el

@

Project Mame:  CobaHellol
@) Create new project in workspace
_ Create project from existing source

_) Create project from existing sample

Use default location

Working sets

[] Add project to working sets

oy
@ < Back MNext >

C:/Users/samsung/workspace/CobaHellol

Browse...

Select...

Finish Cancel
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11. Kemudian pilih Android Target sesuai dengan HP yang dimiliki.

= New Android Project = =
Select Build Target p g
Choose an 5DK to target .-1
g
Build Target
| Target Name Vendor Platform  API.. *
|
[#] Android 21 Android Open Source Project 21 7 |2
Google APIs Google Inc. 21 7
| Android 2.2 Android Open Source Project 22 8
Google APIs Google Inc. 22 8 i
Standard Android platform 2.1
( ? | < Back || Mext » Finish | Cancel |

12. Kemudian pilih minimum SDK yang sesuai dengan HP yang dimiliki.

= New Android Project = @

Application Info
Configure the new Android Project | 1

Application Name: CobaHellol

Package Name: praktikum.cobahellol
| Create Activity:  CobaHellol Activity

Minimum SDK: 7 -

13. Kemudian periksa project yang telah dibuat dengan menampilkan Graphical
Layout dari main.xml sepeti gambar dibawah:

2 *mainxml £3 =0

Editing config: default |An}r locale - | |Andr0id 21 vl | Create... |

37in WVGA (Nexu v [Po |[Ne v [Da »[Theme -

& Palette ~ | mE| EQEaqa®
[ Form Widgets @ ~
[] Text Fields
[ Layouts

[ Composite
Images & Media

m

[] Transitions
[T Advanced
Custom ...ry Views || 4 )
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14. Lalu tambahkan gambar icon seperti berikut ini:

I

15. Jika telah selesai maka click button Run dan akan ditampilkan menu seperti
berikut, lalu pilih Android Application.

2 Runks = e

Select a way to run 'KonverterSuhu':

[T Android Application
J5 Android JUnit Test
9] Java Applet

[T1Java Application

Ju lUnit Test

Description

16. Jika tidak ada kesalahan maka akan ditampilkan pada emulator seperti terlihat
dibawah ini:

Sl @ s:27Am
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Praktek 2 : Program Konverter Suhu

1. Pertama-tama butlah project baru, misalnya dengan nama KonverterSuhu.
Selanjutnya pada Package Explorer akan terlihat susunan seperti berikut:

f% Package Explorer &2 - <-}==5| ¥ =0

‘_,S KonverterSuhu
8 src
2 konverter.suhu
KonverterSuhuActivity java
Gﬁ gen [Generated Java Files]
1 konverter.suhu
= Android 2.2
=, Android Dependencies
G@ assefs
& bin
= res
= drawable-hdpi
= drawable-Idpi
= drawable-mdpi
== drawable-xhdpi
= layout
) mainxml
= wvalues
) strings.xml
47 AndroidManifestxml
|Z| preguard-project.txt

project.properties

2. Langkah kerja aplikasi Android pertama kali akan memeriksa file
AndroidManifest.xml pada project kita. Dalam file tersebut, sistem android akan
mencari sebuah element <activity> yang ditetapkan sebagai LAUNCHER,
ditandai dengan memiliki elemen <category> dengan atribut
android:name="android.intent.category. LAUNCHER".

3. Kita lihat file AndroidManifest.xml dalam aplikasi KonverterSuhu, seperti berikut.

<Pxml versian="1.0" encoding="utf-8"F>
<manifest zxmlns:android="htitp://schemas.android. com/apk/res/android”
package="kanverter.suhu”
android:veraianCode="1"
android:wversionlame="1_0" >
<uses-gdk android:minSdkVersian="7" />
<applicatian
android:ican="@drawable/ic launcher"”
android:label="fstring/app nam=" >
<actiwvity
android: name="kanwverter. suhu . KanwverterSuhuldctivity”
andraid: la.bel="é'string/app_name -

<intent-filter>
<actian android:name="android.intent.actian. MATIN" />
<category android:name="android.intent.category.LAUNCHER" />
</intent-filter>
<Sactivity>
</applicatian>
</mani fest>
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4. Kemudian edit file KonverterSuhuActivity.java seperti contoh dibawabh ini. File
inilah yang mengatur logic dari aplikasi, berdasarkan informasi yang ada di
AndroidManifest.xml, maka file inilah yang akan dijalankan pertama kali ketika
user ingin menjalankan aplikasi.

pPackage konrerter. soho

import konverter. suho. B

import android. app.Activity:
import android. os.Bondle;

import android. view. View:

import android. widget. EditText
import android. widget. RadioBotton;
import android. widget. Toast .-

public class EonrverterSohol otivity extends Activity |
Private EditText text:

A0vmrri de
public void onCreate(Bundle savedInstanceState)
super. on(reate{savedInstanceState) -
setContent View(R. layon t. main) -
text = (EditText) findViewById{R.id. editTextl) -
¥

£ memthod mntonk oclick bottom
public void mpClickHandler (View view)
switeh (view.getId{)) {
case R.id. bottoni:-
BadioButton celsinsBotton = (RBadiocBuottom)
FindViewBrId(R id.xadiold)
BadioButton fahrenheitBotton = (RadiocButton)
FindViewBrId(R id.xadicl)
if {teat. getText (). lengthi) = 48)
Toast.makeText{this, "Input salak!"”,
Toast. LENGIH_I&NGJ .show()

retoEn s

float imputValaoe= =
Float.parseFloat(text. geitText () . toStxngil) -
i¥f (celsivsBotton.isChecked()) {

text  setText(String. valoedf (konversiFahrenheitToCel sins (inpot Valoe=) ) ) -
ce=lsinsBotton . setCheckead (false=) -
fahrenheitBotton. setChecked (Exrme) -
F =lse= {

text_ seitText(String.valoeOf(konrerciCelcinsToFahrenheit (inpotValo=)) ) -
fahrenheitButton. setCheckedfalse=) -
calsipsFotton.setCheckad tro=] -

break:

}

/¢ komversi ke celsims

private float konmrersiFahrenheitToCelsins{float fahranheit) |
ratoern | (fahrenheit - 32) * 5 7 8) -

}

/¢ komversi ke fahrenheit

private float konmrersiCelsinsToFfahrenheit{float celsins) |
retorn | foelsizms * ) 4 5) + 32-

}
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5. Class KonverterSuhuActivity diatas merupakan sebuah class turunan dari class
Activity. Metode onCreate pada class diatas akan dipanggil ketika activity ini
ingin dijalankan (ditampilkan di layar). Yang perlu kita perhatikan disini adalah
pada baris setContentView(R.layout.main);. Artinya, file xml yang akan digunakan
menjadi tampilan activity ini adalah pada file dengan nama main.xml dalam folder
res/layout/ pada project kita.

6. Kemudian edit file main.xml seperti contoh dibawah. File inilah yang mengatur
tampilan, sesuai dengan parameter yang diberikan ke metode setContentView().

<?7wml wversion="1.0" encoding="utf-8"2>
<LinearlLayout zmlns:android="http://schemas.android.com/apk/res/android”
android:layout width="fill parent”
android:layout height="fill parent”
android:background="§gco Lor/myColor "
andreid:orientation="vertical” >

<TextView
android:layout width="fill parent”
android:layout height="wrap content”
android:text="gstring/hello” />

<Edi tText
android:id="g+id/edit Textl "
android:layout width="match parent”
android:layout height="wrap content”
android:inpn tType="numberDecimal|numberSigned” >
</EditText>

<RadioGroup
android :id="@g+id/radioGroupl "
android:layout width="match parent”
android: layout height="wrap content” >

<RadiocBut ton
android:id="g+id/radio0"
android: layout width="wrap content”
android: layout height="wrap content”
android:checked="true" N
android: text="gstring/celsing"™ >
</RadioButton>

<RadiocBut ton
android:id="g+id/radiol”
android: layout width="wrap content”
android: layout height="wrap content”
android: text="gstring/fahrenheit” >
</RadioButton>
</RadioGroup>

<Button
android:id="g+id/buttani ™
android:layout width="wrap_ content”
android:layout height="wrap content”
android:onClick="myClickHandler"
android:text="gfstring/calc” >
</Button>

</LinearLayout>

7. LinearLayout merupakan format layout yang paling sering digunakan dalam
aplikasi Android. Format ini menempatkan menampilkan komponen Ul (button,
textview, dll) secara berurutan berdasarkan penulisannya. Seperti namanya,
TextView digunakan untuk menampilkan text. Text yang ditampilkan langsung
ditulis atau merupakan referensi ke variable string dalam res/values/strings.xml.
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Dalam contoh di atas, text yang akan ditampilkan adalah string dengan nama
"hello".

8. Pada Graphical Layout file main.xml akan terlihat seperti contoh berikut:

[3.?in WVGA (Mexus Or vIPortra "][Norm. vIDaytir vlTheme

|Z| Palette - III]| Q Q @
[ Form Widgets
(7] Text Fields
[ Layouts

[T Compaosite
() Images & Media O e celsivs

O Time & Date . ke Fahrenheit

[_) Transitions w

() Advanced
= Custom & Library Views 1
Graphical Layout| = main.xm||

9. Kemudian edit file string.xml tempat mendeklarasikan beberapa string, seperti
contoh berikut:

<?xm]l version="1.0" encoding="utf-g&"?>
<resources>

<color mame="myColor">#AA55CC</color>

<string name="app name"*HaonverterSuhu</string>

<3tring mame="hello">Isilah suhn pada kolom dibawah</string>
<3 tring mname="myClickHandler">my(ClickHandler</string>
<gtring name="celsins">ke Celsins</string>

<string name="fahrenhei?7>£§ Fahrenheit</string>

<3tring mame="calc">Kanversi</string>

</resources>

10. Jika proses edit telah selesai semua, maka click Run, lalu tunggu beberapa saat,
maka pada emulator akan terlihat seperti contoh berikut:
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Za il @ 8:49em
KonverterSuhu

Isilah suhu pad

o ke Celsius

. ke Fahrenheit

Cara kerja aplikasi diatas adalah sebagai berikut:

1.

Ketika pertama kali aplikasi dijalankan (activity dibuat), method onCreate()
dieksekusi. Di dalam method ini, terdapat pengaturan tampilan layar dan
pengambilan 1D dari text field.

Dalam Android, tampilan text field direpresentasikan oleh class editTextl. Setelah
method onCreate() dieksekusi, selanjutnya Android mengeksekusi method
onResume().

Karena activity baru diluncurkan pertama kalinya, belum ada nilai yang tersimpan
di inputValue sehingga variabel text bernilai null, dan jika akan diisi dengan cara
meng-click didalam textfield maka akan ditampilkan keypad Android pada sisi
bawah.

Ketika aplikasi akan dieksekusi dengan memilih radio button “ke Fahrenheit”,
maka nilai yang diisikan kedalam text akan dikonversikan ke Fahrenheit.
Selanjutnya dengan meng-click button “konversi” maka inilah saat yang pas
untuk menyimpan nilai dari textfield atau menyimpan konten dari textfield.

Jika kita lihat kode di dalam KonverterSuhuActivity.java, maka kita akan melihat
proses penyimpanan konten text dan diberikan ke method
konversiCelsiusToFahrenheit() untuk dikonversikan. Selanjutnya hasil kalkulasi
akan disimpan dalam text sebagai nilai hasil kalkulasi, dan nilai text inilah yang
selanjutnya ditampilkan ke textfield.
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